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Public Service Commission 

Computer Operator Practical Examination 
Sample Set - 11 

 
F.M.: 30  P.M.:15  Time: 30 Minutes  
 
Attempt all of the following questions:  
 
Create a folder on desktop and name it your symbol number. Save all of your files inside that folder.  
 

Group A (Word Processing) 

 

1. Enter following text and perform actions as asked: [10 marks] 

Insert Tab 

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of 

your document. When you create pictures, charts, or diagrams, they also coordinate with your current 

document look. 

Home Tab 

You can easily change the formatting of selected text in the document text by choosing a look for the 

selected text from the Quick Styles gallery on the Home tab. Most controls offer a choice of using the 

look from the current theme or using a format that you specify directly. 

Document Theme 

To change the overall look of your document, choose new Theme elements on the Page Layout tab. To 

change the looks available in the Quick Style gallery, use the Change Current Quick Style Set 

command.  

a. Apply suitable heading style to the titles 

b. Apply one-and-half line spacing to the paragraphs with justified alignment 

c. Insert a table of contents at the beginning of document 

d. Enter 'Go to top' text at the end of document and configure in such a way that MS Word will 

jump to the Table of Contents if it is clicked. 

e. Convert headings into small caps. 

Group B (Spreadsheet Calculation) 

 

2. Enter following data in spreadsheet and perform as asked:  [10 marks] 
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a. Enter and format data as displayed above  [4 marks] 

b. Calculate Queued as the difference of Orders and Shipped [2 marks] 

c. Assign Tracked as NOVA for those having more than 40 orders and less than 20 Queued. 

All others are ALMU. [2 marks] 

d.  Display Shipped for all the Sales Girls in 3D Column chart.  [2 marks] 

 

Group C (Database Management) 

 

3. Create a table to store name, address, email address and mobile number of your friend. Then write 

a query so that it will display name and mobile number when user enters email address. [4 marks] 

 

 

Group D (Presentation System) 

 

4. Create a presentation with 3 slides. The first slide will contain title and subtitle. Second slide 

should contain title and a chart. The last slide will contain the text 'Thank You'. Apply 'Textured' 

slide design to the presentation.  [2] 

 

Group E (Website Design) 

 

5. Write HTML code to create a webpage in following layout using framesets.   [3] 

 

ICT Trends 
Prepare Computer Jobs Exams 

Menus: 
Gold Membership 

eCourse Membership 

Free Membership 

Welcome to the ICT Trends. Hope it will be most useful to 
prepare your exam. 

© ICT Trends 2012  |  About | Contact Us | Disclaimer | Privacy Policy 
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Public Service Commission 

Computer Operator Practical Examination 
Sample Set - 12 

 
F.M.: 30  P.M.:15  Time: 30 Minutes  
 
Attempt all of the following questions:  
 
Create a folder on desktop and name it your symbol number. Save all of your files inside that folder.  
 

Group A (Word Processing) 

 

1. Create a document with following text and format as displayed: [10 marks] 

 

 
in ICT Trends Prepare provides 

access to some of the exclusive 

content to help you prepare your 

Computer Jobs Examination. 

Unrestricted access to Downloads, 

MCQ Banks, Online Quiz and Online 

Text Books! 

 

a. Write following text as comment for ICT Trends Prepare of second line: 
http://prepare.icttrends.com 

b. Apply shadow border to Computer Jobs Examination only. 

 

Group B (Spreadsheet Calculation) 

 

2. Enter following data in spreadsheet and perform as asked:  [10 marks] 

 

SN EMP 

Code 

Sales 

AMT 

Commission Earning Tax Net 

Earning 

1 1001 5000     

2 1002 3800     

3 1003 4000     

 

a. Enter above data in Affiliate sheet in 2010 workbook [2 marks] 

b. Calculate Commission as 7% of Sales AMT [1 marks] 

c. Calculate Earning as sum of Sales AMT and Commission [1 marks] 

d.  Calculate Tax as 13% of  Earning for all Sales AMT equal or more than 4000.  [2 marks] 

e. Calculate Net Earning as the difference of Earning and Tax [1 marks] 

f. Create a column chart showing Earning and Net Earning for each EMP Code. [3 marks] 
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Group C (Database Management) 
 

3. Enter following in Access database and display in report the Name and Phone Number of all 

female employees. [4 marks] 

 

EMP Code FName LName Sex Address Phone Number 

1001 Kabita Krishnamurti F Pune, India 6473219 

1002 Kripa Rana F Baglung, Nepal 4532345 

1003 Buddhi Parajuli M Pokhara, Nepal 5433453 

1004 Anjali Gyawali F Kathmandu, Nepal 4321123 

1005 Ram Katawal M Parbat, Nepal 4566547 

 

 

 

Group D (Presentation System) 

 

4. Create a presentation to describe your village with 4 slides. Apply 2 seconds transition to every 

slides.  [2 marks] 

 

Group E (Website Design) 

 

5. Create a HTML web page for a restaurant with three frames. The first frame will be horizontal on 

top displaying the name and address of restaurant. Second frame which is vertical on left will list 

the available food items. The third frame will be to the right of second frame and will display the 

introduction to the restaurant. Save your webpage in Restaurant folder inside your working folder. 

[3 marks] 
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Public Service Commission 

Computer Operator Practical Examination 
Sample Set - 13 

 
F.M.: 30  P.M.:15  Time: 30 Minutes  
 
Attempt all of the following questions:  
 
Create a folder on desktop and name it your symbol number. Save all of your files inside that folder.  
 

Group A (Word Processing) 

 

1. Create a document with following text and carry out the tasks mentioned below: [10 marks] 

“Before starting, check that you are viewing this in Microsoft Word.  If you left clicked on the link 

in your web browser to come here, you will be viewing this through Internet Explorer.  You can 
check this by clicking on the Help menu and seeing if it lists either “About Microsoft Word” or 

“About Internet Explorer”.  If it says, “About Internet Explorer” you have opened this fine in the 

incorrect way, and so you can use the Back button on the browser to go back and download the 

document in the correct way.  If it says “About Microsoft Word”, you’ve done it correctly – carry 

on.” 

a. The left and right margins are to be brought in by 1.2cm and 2.4cm respectively 

b. Indent the first line by a further 1 cm 

c. Align the paragraph to the right hand side of the page. 

d. Apply double line border at the top and bottom and single line border on left and right of 

paragraph. 

e. Change all Microsoft of paragraph in MS. 

 
Group B (Spreadsheet Calculation) 

 

2. Create a line chart from following data:  [10 marks] 

 

Product January February March April May June 

Platinum 7000      

Gold 2002      

Silver 3003      

 

Fill up the blank cells with following information: 

a. The quantity of Platinum and Silver was increased by 20% in February and March.  

b. The quantity of Platinum is decreased by 5% in April and 4% increment in May and June 

c. The quantity of Gold was steadily increasing by 3% in every months 

d.  The quantity of Silver was decreased by 2% in April, May and June 

 

Group C (Database Management) 
 

3. Create a Hospital database and following tables in it: [4 marks] 

Patient:  PatientID, Name, Address, DateOfBirth, DoctorID 

Doctor: DoctorID, Name, Address, JoinDate 

Treatment: TreatmentID, DoctorID, PatientID 

Medicine: MedicineID, Description, DoctorID, TreatmentID, PatientID 

 

Create suitable relationship between those tables. 
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Group D (Presentation System) 

 

4. Create a presentation for a teacher to present in his class about Computer Generations. The 

presentation should contain 5 slides, one for each generation. The text should appear flying in 

when slide show. [2 marks] 

 

Group E (Website Design) 

 

5. Write HTML code in notepad to perform following tasks. [3 marks] 

a. Display 'ICT Trends' moving alternating in width of web page 

b. Display 'Exam Preparation Sessions' in heading 3 format. 

c. Display following text as square bulleted list: 

 ICT Trends Prepare 

 ICT Trends Forum 

 ICT Trends Downloads 

 ICT Trends Videos 



Visit http://www.icttrends.com 

Composed by Suresh Khanal for www.icttrends.com  

Public Service Commission 

Computer Operator Practical Examination 
Sample Set - 14 

 
F.M.: 30  P.M.:15  Time: 30 Minutes  
 
Attempt all of the following questions:  
 
Create a folder on desktop and name it your symbol number. Save all of your files inside that folder.  
 

Q1.  Design in MS Word. 
a)      Crate Page 1 and 2 in Portrait 

b)      Crate Page 3 Landscape 

c)      And 4 and 5 in A4 Portrait. 

 
Make this Table in Page no 2. 

 
Use Header and Footer in every page. 

 

Q2.  Calculate the Increment using by excel. 

 
A Trading company distributes incentive salary to the staff 25000/- because of company 

boomed up. 

 
 

Calculate the increment Salary 

 Calculate the Percentage 

(After increment Salary – Before Increment Salary)/Before Increment Salary *100 

 Show the percent in pie chart view. 

 

Q3.  Crate two Table one where Employee ID and Name and make next table where Employee ID, 

Address and Salary. Enter the 3 records using form and Show the employee id, Name and 

salary and print this report whose Salary is more than 12000/- 

 

Q4.  Make Three slide in Power Point 
Information System…….. 

Prepared by……………….. 

Scope of Information System: 

 (write long sentence in second Slide using Bullets) 

Feature of Information System: 

 (write long sentence in Third Slide using Bullets) 

 

a)      All Slides must Play automatically within 10 sec. 

b)     All Text will fly Top to Right Transition. 

http://icttrends.com/images/text-page-2.png
http://icttrends.com/images/excel_sheet.png
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Q5. Make a Frame-set webpage using by Notepad. 
 

 

http://icttrends.com/images/frame_001.png


Visit http://www.icttrends.com 

Composed by Suresh Khanal for www.icttrends.com  

Public Service Commission 

Computer Operator Practical Examination 
Sample Set - 15 

 
F.M.: 30  P.M.:15  Time: 30 Minutes  
 
Attempt all of the following questions:  
 
Create a folder on desktop and name it your symbol number. Save all of your files inside that folder.  
 

Group A (Word Processing) 

 

1. Create a document with following text and carry out the tasks mentioned below: [10 marks] 

 

tkfO{sf] ;kmntfsf] Ps c+u aGg kfpmFbf ue{flGjt 

ICT Trends Prepare! 
 sn+sL, sf7df8f}F 

 http://www.icttrends.com 
kq ;+VofM ========= ldltM @)^(.)*.!& 

 

>Ldfg\ k|aGwsHo" 

OGkmf]l;; l8:6«LJo'6;{ 

k'tnL;8s, sf7df8f}F . 

 

ljifoM ;fdfg pknAw u/fOlbg'x'g . 

 

pk/f]Qm ;daGwdf o; ICT Trends Prepare nfO{ tkl;n adf]lhsf ;fdfgx? cfjZos /x]sf]n] 

oyfzSo l56f] pknAw u/fOlbg' x'g cg'/f]w 5 . 9'jfgL kZrft\ aLn e'QmfgLsf] lglDt lan k]z ug'{xf]nf .  

 

tkl;nM 

!= EP 26 Toner sfnf] !)))) yfg  

@= USB Splitter $ kf]6{ *) yfg 

#=  * lh aL Kingston Pen Drive !))) yfg  

 

Administrator 

-;'/]z vgfn_ 

a. Set top margin by 3 cms and all other sides 2 cms. 

 

Group B (Spreadsheet Calculation) 

 

2. Enter following data in Excel worksheet:  [10 marks] 

 

Product Date Qty Rate Disc % Amount 

USB Extension  150 186 7  

Pen Drive  300 1600 12  

Memory Sticks  500 668 7  

 

Fill up the blank cells with following information: 

a. Display current system date in Date column in YMD format such as 13 Oct 2012 

b. Format the Rate column with one decimal digit and currency such as Rs. 186.0 

c. Calculate Amount for each row  
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Group C (Database Management) 

 

3. Make an Employee table in Access database with following fields and apply Primary key to a 

suitable filed: [4 marks] 

Employee:  FName, LName, Address, DateOfBirth, Department, Designation, CitizenshipNumber 

 

Create a form to enter records. Similarly, create a query to display the record when citizenship 

number is entered. 

 

Group D (Presentation System) 

 
4. Create a presentation to introduce Public Service Commission. Make slides to change in every 2 

seconds automatically. Display slide number at the top right corner in every slide. [2 marks] 

 

Group E (Website Design) 

 

5. Write HTML code in notepad create following list. [3 marks] 

1. Gold Membership 

i. Downloads 

ii. Online Quiz 

2. eCourse Membership 

i. Session eMails 
ii. Online Text Books 

3. Free Membership 

i. User Question Forum 

ii. Public Content 

Insert hyperlink to http://prepare.icttrends.com/order on Gold Membership. Insert a picture at the end 

of web page. 

 

http://prepare.icttrends.com/order
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